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Welcome to the latest edition of my monthly Final Cut Studio newsletter for April, 2008.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are archived at the end of each 
year with key articles posted on my website for your reference. All software references are to 
Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find over 300 
articles tutorials to help you get the most out of Final Cut!
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WRAP UP

Welcome!

It's the week before NAB 2008 - and I'm getting excited! NAB is my favorite toy store. (Last year, I almost 
bought a six-million dollar helicopter... except my wife reminded me that I couldn't park it in front of the 
house... Well, OK, that and the fact I have NO use for a helicopter and it was a little out of my price range.) 
But I never let reality get in the way of having a good time at NAB! 

There's nothing quite as exciting as looking over all the newest gear for production and post. Plus, there's 
the added bonus of talking with some of the best and brightest in our industry during the entire week.

I'll have more about NAB in the next story. 

But I'm excited about more than just NAB - we have four new announcements this month - including TWO 
NEW podcasts! So, let's get started!

[ Go to Top. ] 

Join Us at the FCP SuperMeet at NAB 2008!

If you are going to NAB, come say HI at the FCP 
Supermeet, Wednesday night, April 16! Mike Horton and 
Dan Berube are planning a complete three-ring circus - all 
focused on Final Cut Studio.

I'm delighted to be the MC for the evening. Plus, we'll have a booth at the event where you can say HI to 
Debbie, Kristi, and Cirina - all members of our team. As an added bonus, you can even see what the future 
holds when you visit!

The room holds 1,200 people and there are only a couple hundred seats left, so be sure to register before 
you leave for NAB.

Click here to learn more.

I look forward to seeing you there!
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It's a Contest and It's FREE!
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Yup, a contest -- just for editors! We call it: "Editing Truths for Better 
Living." 

Here's how it works: in 20 words or less, send us your favorite editing 
truths. You know the type:

* Never have so few done so much with so little. 
* Picture lock isn't. 
* Nobody checks spelling until the master has been laid off to tape.

Right. THOSE kinds of truths.

We've already posted some of the initial entries to our website. You can read them here.

Winning entries - and we have very low standards - will be published on our website and will receive a 
FREE "Almost 30 of Larry's Favorite Final Cut Keyboard Shortcuts" mouse pad.

Click here to learn more - enter as often as you like. 

There's no money in it, just fame, glory, and the pride that comes from knowing that all the pain you've 
suffered from difficult clients can actually win you something. Oh, yeah. And a mousepad! 
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Technique: Shooting a Live Band

by Steve Oakley 

Steve Oakley normally writes on Premiere Pro for the Digital Production BuZZ Tips and 
Tricks newsletter which I edit. Recently, however, I read an on-line posting he wrote on what 
it takes to record audio live. I was so impressed with his comments that I asked him to let me 
include them here. 

While not strictly related to Final Cut, many of us do both production and editing, so I thought 
you'd be interested in reading them, as well.

I've done all sorts of live music shows from clubs with 500-1,000 people to 25,000-seat arenas MSG, 
Nassau Coliseum, Lincoln Center, Las Vegas show rooms, and live outdoor events with thousands of 
people. Somewhere along the line it’s going to happen to you, too. Someone will ask you to shoot their 
band playing live. Maybe it will be a freebie favor for a friend, maybe it will be a decently paid gig, or maybe 
it will be a big show at a major venue.

Let me give you some primary tips to getting the job done right.

* Pick the right audio format 
* Talk to the on-site sound company 
* Select your audio feeds 
* Confirm your levels 
* Lights 
* Cameras

Click here to read the full article.
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Exclusively on Digital Production BuZZ - April 17

If you haven't listened to our Digital Production BuZZ podcast yet, mark your 
calendars for the April 17 show. Mike Horton and I host this live, one-hour 
show each week - but this show is special. 

For the first time ever, we will be interviewing the video product managers for 
Avid, Adobe, and Apple all on the same show! This is a very rare opportunity 
to learn what's happening from the three leading companies in our industry.

All the interviews will be done at NAB, so we'll have all the latest news. 

Then, we'll be talking with David Wertheimer, executive director of the Entertainment Technology Center at 
USC on his NAB presentation: New Devices, New Opportunities. 

Plus, we'll have extensive coverage of the FCP SuperMeet, and many other surprises!

The show airs live Thursdays from 6 - 7 pm PDT. Listen live or download it from iTunes or your favorite 
podcast reader.

To listen to this week's show, click here.

To visit our archives, click here.

Please tell your friends about our April 17 show. It promises to be amazing.
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2007 Newsletters Now On-Line

One of the questions I get asked a lot is whether past newsletters are available. While 
I don't post individual issues, I do bundle them on an annual basis. 

So, I've bundled all the 2007 issues (over 300 pages worth) into a single, 
downloadable package for only $29.99.

If you want to learn more about the technology we are all working with today, or 
rediscover the tips you've forgotten, there's no finer resource than these newsletters.

Click here to learn more.
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Working with 16:9 Material in DVD Studio Pro

Joseph Cochran sent in the following:

I'm currently finishing up a DVD for an independent film I shot in 16:9 anamorphic on a 
DVX100a SD camera. I've encoded the resulting footage as a 16:9 MPEG-2 streams 
accordingly. Ideally, I'd prefer to structure my DVD with the 16:9 footage in the Pan-Scan & 
letterbox display mode so that when it plays on HDTV sets, it will be able to utilize the entire 
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16:9 screen area. If I were to structure the DVD preferences simply in the 16:9 letterbox 
display mode instead, then it seems that not only would black letterbox bars appear on the 
top and bottom of the footage, but vertical black bars would also appear on the sides as well 
when playing back on HDTV's--something I would like to avoid if at all possible. Furthermore, 
I've also read in several places that many, if not most, DVD players can recognize SD 16:9 
(pan-scan & letterbox) wide screen DVD's and automatically play them as letterboxed on 
NTSC TV sets. How true is this? 

(So far, I've been able to test my pan-scan & letterbox DVD's out on a few different DVD 
players and they seems for the most part to hold up... not to mention the numerous wide 
screen DVD's that come out of the movie studio system. But I also realize that I've only been 
able to test a small fraction of the DVD players that are out there.)

The thing that gives me pause is that I was recently listening to your tutorial, "DVD Studio Pro 
4 Essential Training" in which you suggested 16:9 letterbox display modes and preferences 
should be used as opposed to 16:9 pan-scan & letterbox display mode and preferences. Why 
is that?

Larry replies: Joe, thanks for writing.

Just to restate, there are four aspect ratios available inside DVD Studio Pro:

�●     4:3
�●     16:9 Pan-Scan
�●     16:9 Letterbox
�●     16:9 Pan-Scan & Letterbox 

According to the DVD Studio Pro manual, these control how a 16:9 image is displayed on a 4:3 monitor.

Apple's manual states: 

Using 16:9 sources in your project raises a number of issues that you need to be aware of. 
Your main goal is to ensure that 16:9 assets play back correctly on 16:9 monitors and as 
expected on 4:3 monitors (and that 4:3 assets play correctly on both monitor types as well). 
Incorrect settings can lead to distorted video. For example, the video may appear horizontally 
compressed (objects look “skinny”) or expanded (objects look “fat”).

...The DVD specification and DVD Studio Pro require 16:9 video to be anamorphic. An 
anamorphic 16:9 video frame has the same number of pixels as a 4:3 video frame. When 
displayed on a 16:9 monitor, the frame is horizontally stretched to fit the screen, and the 
content appears normal. 

...The most common error is to letterbox your 16:9 video assets before bringing them into 
DVD Studio Pro. Once a 16:9 asset has been letterboxed, it becomes a 4:3 asset with black 
bars along the top and bottom of the video image. If you flag letterboxed source video as 
16:9 video when encoding it, you will have problems when you play it back later. 

So, here's the way this works: 

�●     If you have 4:3 material, select 4:3.
�●     If you have 16:9 material, select 16:9 letterbox. This means your video will play properly on 16:9 



monitors and be letterboxed on 4:3 monitors.
�●     If you have pan-and-scan vectors created for your video -- and neither Compressor nor DVD Studio 

Pro support the creation of these vectors, nor will they compress video to include these vectors -- 
then select 16:9 Pan-Scan.

�●     If you want the viewer to choose between letterbox and Pan-and-scan AND you've encoded the pan-
and-scan vectors, select 16:9 Pan-Scan & Letterbox.

Remember, these selections are used to determine how your 16:9 video plays back on a 4:3 monitor.
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Monitor Dimensions are Driving Him Nuts!

Eric Jabouille writes:

I just wanted you to know that PERHAPS, in a next tutorial, it would be good to have a recap 
on all the video formats!

I was just watching Apple's demo on the MacBook Air and I realize that their format is 
320x200 for iPods (this 200 seems weird) and their "large" format is 848x528...(can't figure 
out what's the "medium" size).

These formats are NOTHING I have learnt about in any of the tutorials or books I've read. 
How comes everything is so crooked and weird like that Larry? I wish I could have a few 
figures that make sense! 

If I'm not the only one to ask, please, please, think about making a short tutorial one day 
about "All the things you've always wanted to know about video formats but were afraid to 
ask"!!!!

These figures are not presets in Compressor either! Arrggghh!



Larry replies: Eric, before you start jumping in front of large moving trucks, relax...! It's not as bad as you 
think.

You are confusing monitor size with video playback size. All Apple monitors currently support an aspect 
ratio of 16:10. This allows the playback of a 16:9 movie with room for a menu bar at the top.

320 x 200, 848 x 528 are all 16:10 dimensions.

Standard HD video frame sizes use 16:9 aspect ratios:

* 1920 x 1080 
* 1280 x 720

If you are displaying HD to a TV set, you must use one of these two 16:9 sizes.

However, when compressing a video for the web, you can use any size you want; as long as the aspect 
ratio of the compressed movie matches the aspect ratio of the original source.

So, for 16:9 source material, any of these sizes (and many others) would work:

* 160 x 90 
* 320 x 180 
* 480 x 270 
* 640 * 360

... and so on.

Hope this helps slow your heart rate down! 

[ Go to Top. ] 

Technique: Using Leopard's Help System

Ben Balser sent in the following:

I was just taught about Leopard's new Help system by my buddy Tim, an Apple sales engineer. This is so 
cool, and it works in pretty much any application. For the FCS apps, this is really helpful!

Preface

We all know that you can access the user manuals by going to the Help menu. But in 
Leopard you'll also see a Spotlight field. Spotlight is the search function that has always been 
a part of OS X.

So instead of clicking on the "user manual" to bring it up, when you go to the Help menu, 
simply type a term you need to know about in the Spotlight field, and that's all. Don't press 
enter or click on anything. 

When you do, a list will appear below that replaces the user manual menu with 2 categories 
in a new list: Menu Items, and Help Topics.

Menu Items

Then simply move your mouse cursor over one of the entries on that list, and guess what 
happens? It will drop the appropriate menu and sub menus, and an arrow will float there 



pointing to that function in the menu. (Yes, it floats, it bobs, its cool!)

And if you can automatically see where the function is in the menu, you can instantly see the 
keyboard shortcut (if any) for that menu function, also!

Help Topics

Below the menu entries will be a list of entries in the user manual (for apps that support on-
line user manuals). You can simply click on one to open the user manual to that entry.

I'm attaching a couple of screen shots from some apps to show you. This works in pretty 
much ALL apps. From what I understand, this is also a programmable thing to some extent, 
so that software programmers can do some cool stuff with this function, but don't hold my feet 
to the fire on that statement.

Here's an example of the help system inside Final Cut Pro 6.

And here's another example, this time inside Compressor. 

This also works with third party plug-ins in FCP and with non-Apple apps like Studio Artist.

This is pretty cool! 



Larry replies: Thanks, Ben, for sharing this!
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Announcing: The Final Cut Studio Tip of the Day

Looking for faster ways of working with Final Cut Studio? Our Tip of 
the Day is the solution.

This is BRAND-NEW and COMPLETELY FREE! We are launching this at NAB, but I wanted to give you a 
sneak peek this week! (This screen shot is just a mock-up - the official launch date is April 14.) 

We've collected hundreds of tips - so we are posting a new tip every day - seven days a week. Even better, 
we've turned this into an RSS feed, so you can easily get the latest tips on your RSS reader.

Plus, for those of you with a website, you can add the Tip of the Day to your website, and provide free tips 
to all your visitors - automatically, with no extra work. To get the necessary code to add to your web page, 
send us an email.

I've wanted to do this for a long, LONG time. Thanks to Srithip Prime and Sudd Dongre for the 
programming to make this possible!
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Finding Unused Footage

Bob Cusumano writes;

Is there a way to find media not used in a final sequence, that you have digitized? I want to 
delete whatever was digitized and NOT used in my project. 

Larry replies: Yes! It's easy. And I just realized I've never written about this before. 

mailto:srithip@larryjordan.biz?Subject=Send me the Tip of the Day!


Here are the steps.

1. Select the sequence in the Browser that contains the media you want to keep.

2. Choose Edit > Find (Cmd+F)

3. Change For to Unused Media and make sure Selected Sequences is checked.

4. Click Final All to find all the unused clips.



5. All the clips that are not used in your sequence are instantly displayed in a separate Find 
Results window. You can then decide whether to show them in the Browser or Remove them 
from your Project by using the buttons at the bottom.

Note: this considers a clip "used" even if only one frame is used in your sequence. Also, this only displays 
whole clips. If you want to get rid of portions of clips containing media you are not using, you'll need to use 
Media Manager for that. Here's an article that describes how.

Still, this is a very fast and easy way to recover disk space when you've finished editing a project.
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Still More on Sizing Still Images

by John Bertram 

Nothing has caused more confusion that figuring out what size to create still images on our computers so 
they look right on video.

I've written a number of articles on this, with this one being the most recent.

However, John Bertram wasn't satisfied. So, having an excess of spare time and a high tolerance for 
confusion he decided to do some tests. Here's his report.

I decided to do a series of reference tests to try and finally settle this issue (at least in so far 
as my system currently goes). I also wanted to write things out in my own words -- which 
sometimes even I can understand down the road.

The results can be seen at: http://web.mac.com/jb.net/PS-FCP/PixelTests.html

My system, BTW, uses Photoshop Elements for Mac (v4) along with FCP 6.x. Whether 
Photoshop CS3 handles things any differently may need to be determined, but in the tests 
I've just finished, the conclusion is that for MULTI-LAYERED Photoshop graphics, Final Cut 
takes the square pixels and displays them using NTSC rectangular pixels, making the vertical 
dimension appear stretched. Perhaps this is what you meant by Final Cut "leaving multi-layer 
Photoshop graphics alone". And I think I finally understand why that makes a perverse kind of 
sense: so that FCP can maintain the one-track-to-one-layer live, update-able connection with 
the original .psd file. It simply takes each pixel in the graphic and displays it as a single pixel 
in the Timeline.

But because those pixels are different dimensions, I'm maintaining that the Multi-Layer 
graphic must be vertically "squashed" in Photoshop (to about 89% of its normal height) in 
order for that square-pixeled Multi-Layer image to then display properly in the rectangular-
pixeled world of Final Cut and NTSC DV.

And for artistic reasons if nothing else, what my tests seem to say is that ALL graphics, 
whether single or multi-layered, should logically be created on a "canvas" with the exact 
same 4:3 ratio as the screen on which it will ultimately be displayed. In square computer 
pixels, that means 720x540 (or larger multiples thereof if the graphic is to be zoomed or 
panned). But it remains the case for Multi-Layer graphics that we need to "pre-squeeze" the 
final image before importing it into FCP, thereby maintaining the correct height-to-width 
dimensions within that still precisely 4:3 frame.

The alternative you describe of simply creating any multi-layer graphic at 720x480 seems to 
have two disadvantages:

1.  Your workspace while creating the graphic (which may well include photo images 
already on your hard drive) won't be a true 4:3;

http://www.larryjordan.biz/articles/lj_media_mgr_delete.html
http://www.larryjordan.biz/articles/lj_grfx_look.html
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2.  Your finished product will appear to get stretched vertically when Final Cut substitutes 
its tall rectangular pixels for your graphic's lovingly-crafted square ones.

Furthermore, many of the graphics I'm creating may also have to be used down the road for 
print/publicity material. This is why I typically start off with a much larger canvas, but always a 
multiple of the 720x540 pixel, 4:3 ratio. I just down-res a version to the appropriate size (720 
pixels wide if there's to be no zooming in on the Timeline) before importing into Final Cut. 
(And then, if I want it to be a Multi-Layer file for potential animation in my Final Cut project, I 
also do the "540->480 squash" before importing.)

So, I hope you'll watch the video (<http://web.mac.com/jb.net/PS-FCP/PixelTests.html>) and 
see if you don't come to the same conclusion. I may even be presenting it at the next meeting 
of the Toronto FCP User Group, so you can help me avoid embarrassing myself if there are 
some obvious errors which need correcting.

I'll look forward to hearing your comments if/when you have a moment.

Larry replies: John, this is excellent! 

Everyone, please take a few minutes and look at John's examples. It will change the way you work with still 
images. You can see them here: http://web.mac.com/jb.net/PS-FCP/PixelTests.html

Thanks. John, for spending the time to research this and write it up. I look forward to what other people 
have to say.
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Smoother Moves on Stills

Pam Copus sent in a follow-up to my earlier article on getting smooth moves on stills:

I have a terrific (and inexpensive) work-around for this. I use "Photo To Movie" software and 
bring in the .mov to FCP. 

http://www.lqgraphics.com/software/phototomovie.php

I used this on our May release "Deep Still Blue" by 2002 which charted on Billboard:

http://www.2002music.com/CD_DeepStillBlue.html

Larry replies: Thanks, Pam!
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Introducing Our Two NEWEST Podcasts!

DIGITAL PRODUCTION BUZZ - VIDEO 

We are expanding and syndicating the Digital Production BuZZ into 
two NEW podcasts - one video and one audio.

The video podcast is syndicated by GIMP.tv and targeted at new 
digital production users. Global Independent Media Production's 

http://web.mac.com/jb.net/PS-FCP/PixelTests.html
http://www.lqgraphics.com/software/phototomovie.php
http://www.2002music.com/CD_DeepStillBlue.html
http://www.gimp.tv/
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(GIMP) vision is to passionately foster creative invention and 
innovation to global niche markets. GIMP’s mission is to produce, 
distribute and exhibit high quality, engaging programming and 
technology. 

Global Independent Media Productions was founded in August 2005 and is located in southern California. 

Our first eight episodes have been shot. Our goal is to reach the broader market of digital enthusiasts with 
information that will be helpful regardless of which camera, computer, or software they are using. Our initial 
episodes cover subjects such as:

�●     Picking the right HD format
�●     Improving Shooting techniques
�●     Lighting
�●     Improving audio
�●     The art of editing
�●     Getting organized for editing

... and more.

The show is located here: http://www.gimp.tv/digitalproductionbuzz

To subscribe to the video go here: http://feeds.gimp.tv/digitalproductionbuzzvideo

VIDEO PRODUCTION RADIO - AUDIO 

VPR is our newest audio podcast syndicated by 
wsRADIO. This is a monthly show providing highlights 
of the weekly Digital Production BuZZ. If you can't 
afford an hour a week, then Video Production Radio is 
perfect for you.

wsRadio.com started broadcasting on August 15, 2001 
with 5 shows. The ws of wsRadio stands for World 
Syndicated Radio. They have grown to over 120 shows and over 2 million listeners monthly. We are proud 
to claim the title as the largest independent Internet talk radio station in the world.

We produce eBay Radio for eBay, PayPal Radio for Paypal, Marketing Matters Live! for the American 
Marketing Association, PriceWaterhouseCoopers Radio and for high profile companies,  
associatons, and individuals with business, health, hobby, political and special interest shows.

Video Production Radio provides highlights from the best interviews of the last month from Digital 
Production BuZZ 

Our premier show is LIVE 3-4 PDT - Thursday, April 10. Until then, there's just a placeholder for the 
webpage. They tell me the first show will be posted by Friday evening. 

You can learn more by visiting here.
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Working with Tapeless Media

Barry Stone writes:

http://www.gimp.tv/digitalproductionbuzz
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http://www.wsradio.com/
http://www.wsradiopodcasting.com/
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My friend Rick Lecompte (who turned me on to your newsletter) said that you would answer 
questions... So here goes, and thank you in advance. 

I am ingesting AVC-Intra (HDV) media from 4 gig sdhc cards into FCP 6 prores via a 
Blackmagic Design's Intensity Pro card. In order to back up the media I first import it as files 
onto a separate hard drive and then ingest it into FCP on my media drive ( a 5 terabyte 
striped external drive).

Rick said I should not keep my back-up media on the MAC, but I have a 250 gig hard drive 
with FCP and other programs on it and a separate I terabyte hard drive for the original media. 
Is this safe enough or do you think I need to have separate back up for the uningested media.

Larry replies: Barry, thanks for writing.

Here's the issue - when you shoot tapeless you must always be concerned about having multiple copies of 
your footage. What if a hard drive dies? What if you accidentally erased the media? What if the dog ate...

Well, you get the idea.

Where you store the media isn't important as long as two conditions are met:

1.  Never store media on your boot drive.
2.  Never store backup copies on the same drive that you are storing the original files. 

If the footage is easy to replace, keep two copies (one for editing, one for backup) on two separate hard 
drives; not partitions. Whether they are internal or external, FireWire or SATA, is not relevant. The key is 
two separate physical devices. If the footage is hard to replace, keep three copies (one for editing and two 
for backup) on three different hard drives. Once you've copied the media, you can disconnect the backup 
drives, if you want. 

However, at some point, you will need to consider permanent backups. For this, my current 
recommendation is LTO tape drives. They are not cheap - about $2,500 - but the tapes will last 20 - 25 
years - far, FAR longer than any hard drive.

Recently, I've been talking with Bridget Price at Tandberg Data about LTO drives and they sent me some 
white papers that I found interesting. There are three digital tape technologies:

* DLT 
* VXA 
* LTO

Of the three, I think LTO has the most promise for video editors. To help you learn more, here are two links 
she sent me that you can refer to. The first is an overview of Apple-based backup products.

http://www.exabyte.com/partners/apple/research.cfm

This second link is a series of virtual tours of some of Tandberg's products.

http://www.exabyte.com/alltours.html

One of the reasons I'm leaning toward LTO is that the drives are made by a number of manufacturers - HP, 
Dell, Tandberg/Exebyte - so that we are not stranded if one vendor leaves the market.

Also, these products are used daily to back up servers in corporations world-wide. This means that there 
will always be a market for these units and tapes that is much larger than just video editing.
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Another Way to Do Speed Changes

Ed Yost sent in the following, after reading my article on how to change the speed of a clip:

In response to A Better Way to Change the Speed of a Clip, January newsletter.

I had been working on a show for HGTV that was more about the personalities of the people 
than that of a how to show. The show was edited in a comedy style. Often the People would 
rush into and out of frame or run up to camera from some distance off. As editor’s we would 
speed up entrances and exits etc. every opportunity, but always had to work around dialogue 
and to beats of music.

A technique for doing speed changes and keeping my timeline in sync I found very helpful 
follows.

�●     Edit into the timeline the dialogue where you want it to fall or hit a certain phase of 
music. 

�●     Create a video track above that will only be used for speed changes, containing no 
other video. This is kind of a video track just to do rough work in. You may want to 
create two audio tracks also, for example if you wanted to hear the person running to 
camera on a concrete sidewalk.

�●     If you have a two-second phrase of music before the dialogue for the talent to run up 
to the camera that took, say, 20 seconds to shoot in real time, trim the shot to cover 
just that 2 seconds of music. 

�●     Move the video clip up to the empty video track, and move the audio down to the work 
tracks. 

�●     Trim those pieces until I found the frames I wanted the effect to start (20 secs.) 
�●     LOCK all other video and audio tracks (shortcut: Command click the track locks for 

that track) choose Modify > Speed select a duration of 2:00.
�●     Unlock the other tracks
�●     Put the video & audio clips back to the original tracks and you will see a speed 

change with a perfect match frame. This also works better when you up-res the piece 
in an on-line session. 

As a note: when moving tracks of video and audio I generally do not have them linked.(never 
edit with linked pieces & snapping on) But. When doing the speed change have them linked 
so the speed change happens to both video and audio simultaneously. 

Larry replies: Thanks, Ed, for sending this in. I love reading about new ways to do things.

[ Go to Top. ] 

More Thoughts on HDV

Recently, Gary Adcock of Studio37 in Chicago and I got into a discussion about HD and HDV that I 
thought you'd like to read. And, let me state at the beginning that I totally defer to Gary's knowledge about 
HD. Having said that, here's the thread.

A reader asked Gary:

We are getting into HD, specifically, we are developing a series for National Geographic 
which we plan to shoot on HDV. 

1.  What is the best way to capture the material? HDV native? Apple ProRes?
2.  What would be the best way to transfer the material to post-production facility that has 

the xdcam tape?

http://www.larryjordan.biz/articles/lj_change_speed.html


3.  How to I make the sound? we need to deliver stereo and Dolby-e. Does FCP 2 do 
dolby-e?

4.  Since NG here broadcasts from server, can I deliver the movies as compressed data, 
without using Tapes?

5.  Do I need more hardware (We have no capture cards in our studio, we use firewire 
only, but I have access to Blackmagic or AJA cards.

Gary replied:

�●     It is my understanding that Nat Geo will not accept anymore than 10 minutes per hour of HDV 
content in any HD show 

�●     No station or network I have ever heard of accepts XDCAM discs or media for a deliverable - 
HDCam SR is THE universally supported delivery format. 

�●     Nat Geo HD does not accept files for deliverables - Tapes only. 
�●     Dolby-E files need to be created in a Dolby sound suite- and cannot be handled by FCP in any way, 

shape or form.
�●     Yes you will need more hardware- Kona cards are the accepted standard since AJA hardware is 

now found in Discreet, Avid, and FCP systems

Larry then wrote to Gary:

From my understanding, HDV is acceptable as source media provided it is converted thru a 
Snell & Wilcox converter into a standard HD format, such as HDCam SR. So, while 
conversion to ProRes for editing is preferable, it may be possible for him to edit natively in 
HDV, provided he budgets for a hardware conversion process prior to final delivery on tape.

Gary replied:

It is my understanding that even with Snell and Wilcox's Alchemist or Ukon systems or the 
more widely known Terranex, many of the cable networks are still not willing to allow more 
than a limited amount of HDV content per show per hour. I have not seen a delivery guide 
that lists more than a few minutes for HDV content at all, while some even limit P2 and 
XDCAM HD for the same reason (ie: compression ratio of master acquisition).

Shows like Baghdad ER for HBO were completely shot in HDV, however the workflow was 
established as properly converted and edited as uncompressed prior to the delivery of the 
show, all camera masters were converted via Terranex at the same time as being cloned to 
HDcam tape. HBO, Discovery, Nat Geo and others still do not qualify the conversion process 
-- only the camera originals and all of them do limit HDV content (currently that is still less the 
25% of the total viewing time's content) for shows being delivered. 

None of the networks I have mentioned allow for camera native editing of HDV or DV content 
in their original state according to their "written" spec.

Larry adds: Thanks, Gary, for sharing your knowledge. Your comments just reinforce how CRITICAL it is to 
look at the entire workflow and make sure that what you are shooting can be edited and output in a format 
acceptable to your distributor.

UPDATE - April 8, 2008

Gary Childress adds:

I noticed in the newsletter a section on HDV and broadcast delivery formats. HDCam SR is 
NOT a common delivery format for final masters. It's possible that it has been adopted for 
some uses, but regular HDCam and Panasonic D5 are the common delivery formats for 
television, not SR. 

Larry writes: Thanks Gary. I didn't know this. 

[ Go to Top. ] 



READER MAIL

QUICK IMPORT TIP 

Raymond Singer writes:

Your tip on importing files by dragging and dropping from the Finder is a good one, but uses 
an awful lot of fingers.

Because dragging a slew of clips and trying to accurately hit an itty-bitty Bin folder depends 
too much on my fatigue factor, my preferred method is to Control-Click the Bin in the 
Browser I'd like the imported clips to land in and choose Import Files. 

From the Choose a File window, you can preview clips and Command-Click to select the 
ones you want. Click Choose and, voilá!, all your chosen files show up in the Bin you wanted 
them to land in. No chance of missing the Bin.

Larry replies: Slick! I tried this tip this afternoon and it works great. Thanks!

[ Go to Top. ] 

A FASTER WAY TO PAN AUDIO 

Mira Zimet writes:

First of all, I want to tell you that you've been a life-saver this weekend! I just started using 
FCP a few months ago and really had to hit the ground running (have used other non-linear 
systems in past) -- I found quite a few of the answers to my questions on your website and I 
thank you so much for that. I had to output to BetaSP (going to air) and I thank you so much 
for your article on blacking a tape!

Now, I'm on to another problem that I can't figure out -- I also need to output to a post house 
so that they can add a Spanish track -- how do I tell Ch1 and Ch2 (sound-bites) to go left and 
the rest of the channels (nat sound and music) to go right? It's an hour show and I'd hate to 
have to go clip by clip if I don't have to!

Larry replies: Thank you for your kind words! In Final Cut, you can only adjust panning by clip.

However, here's a neat trick. Open your sequence in the timeline and select all the clips you want to pan to 
one side and choose Modify > Audio > Pan Left, or Right, to pan all the selected clips to one side.

This is all to one side or the other, nothing in the middle. Still, it's faster than doing it one clip at a time. 

UPDATE - April 8, 2008

Aaron Brown, from Liverpool, UK, writes:



Something I use a lot is the paste attributes function. If you don't want everything panned 
hard left or right, just hit command-C on the panned original clip before pressing alt-V on the 
target clip(s) and choosing paste attributes - pan. Saves loads of time! 

Then, Nick Meyers sent in the following:

Mira has some clips on A1+A2 that need to be output separately from clips on A3+A4 
the issue is not really one of PANNING, but rather one of ROUTING

The solution to this issue is to change the Audio Outputs of the sequence:

�●     Open Sequence > Settings
�●     Click the Audio Outputs tab 
�●     Change "Stereo" to Dual Mono" and click OK. 

Back in the timeline, in the patch panel (left hand side) right or control click near the lock icon.

Choose Audio output > 1 or 2

This will send an entire track out ether Channel 1 (left) or Channel 2 (right) 

Larry replies: Aaron and Nick, thanks for sending these in. 

[ Go to Top. ] 

BURNED-IN TIMECODE 

John Little of Detroit Public Television writes:

Your tip about applying burned-in timecode works nicely for short sequences, but the 
maximum length of a slug that I have found is 2:10:00. This method seems more 
cumbersome for long programs like I work with, since I would need to set the start time for 
each slug separately. In my case it seems that nesting the sequence and adding a TC reader 
filter makes more sense.

Larry replies: Ah, not so fast. There's a secret tip.

When you load a generator clip into the Viewer - such as a slug - BEFORE you edit it to the timeline, 
change the duration by entering the new duration in the top-left timecode box. 

As long as you haven't edited the clip, you can make it any time you want -- in this example, I've made it 30 
minutes long!

[ Go to Top. ] 



IMAGE STABILIZATION 

Chris Skinner writes:

I am trying to stabilize a wedding clip shot on a mono-pod. I have FCP 5.0.4 which has an 
image stabilization filter in the effects menu under video. There is little on it in the manual. By 
observation one would think you set a target and then establish a range of variability for 
tracking the target. It works OK up to a point in the clip where it makes a some wild jumps. I 
am thinking this where the target moves out of the tracking range. Both parameters can be 
key-framed. All that being said it is still not working very well. Can you perhaps provide an 
example of how to get it to work. Oh bye the way is there a way to put a target in clip; since, 
the existing one is not very good (an illuminated wall sconce in the extreme upper right 
corner of the frame).

Thanks, Larry, I learn from your tutorials on Lynda.com all the time and find your website so 
helpful. Plus I share your sense of humor.

Larry replies: First, my apologies on the sense of humor - I can only imagine what a burden that must be...

Second, the fact you got the image stabilizer in FCP 5.0.4 to work AT ALL is a tribute to your technical skills.

Basically, its awful. Don't bother with it. Don't even try. The one in FCP 6 works really, really well. The 
earlier version is not worth the hard disk space it occupies.

Not, um, that I have an opinion or anything.

[ Go to Top. ] 

MATCH FRAMES FROM A SUBCLIP 

Matt Rogers writes:

[In regard to your article on match framing - ] is it possible to match frame from a subclip and 
match back to the master clip?

I've used Match Frame to source file, but sometimes I insert markers on the master clip and 
create sub clips from the markers (http://larryjordan.biz/articles/lj_convert_markers.html). I 
lose the markers or rather the match to source file doesn't bring me to the master file with the 
markers.

Is there a way to match back to the master clip?

Larry replies: Yes!

Put your timeline playhead in the subclip then press Option+Command+F. The original source clip opens 
in the Viewer with the position of the playhead matched.

Ta-DAH! 

UPDATE - April 8, 2008

Tom Wolsky sent in the following:

Just a little follow-up on this. I use this technique only for speed changes where I don't want 
the sequence to ripple. The reason being that using this media creates an independent clip. 
Cmd-Opt-F obviously doesn't take you back to the original master clip in the browser. 

http://www.larryjordan.biz/articles/lj_match.html


Normally a shot in the timeline is an affiliate shot to the master clip it came from. A subclip is 
a master clip. When you match frame from a sequence from a shot taken from a subclip you 
match back to that subclip. That is the master clip. You cannot get back to the master clip in 
the browser the subclip was taken from. Cmd-Opt-F matches to a new copy of the media. If 
you do that and cut that into the sequence, it is an independent clip. It has no master clip in 
the browser. 

There is a new function in FCP 6, which allows you to add a master clip for this independent 
clip to the browser. If you use Shift-F on that clip you edited in with Cmd-Opt-F you'll get an 
option to add a new master clip to the browser. (Though if you use F on the clip, it will load 
the original master clip from the browser. I have no idea why it knows where it came from in 
one instance, but not in the other.)

Larry replies: Thanks, Tom, for letting us know. 

[ Go to Top. ] 

TWO GOTCHAS IN FINAL CUT PRO 6.0.2 

Alex Tomek sent me the following:

First Gotcha 

I have sent Apple through the submissions page a couple documented notes on a major bug 
and workaround that we have found that is affecting a lot of people on the FCP user forums. 
We have not heard anything from Apple whether they have received our report but I thought 
you could pass this along or get us an email address to send this to somebody over there i 
hoped they can fix this for 6.0.3.

In short, when FCP opens a project that looks for something (media or otherwise) in a folder 
that the current user doesn't have access to, it then returns the "unreadable or too new" error 
message, instead of handling missing media or files normally.

Basically instead of saying, "I don't have access to the folder, so I don't know if the media is 
there, therefore, as far as I'm concerned the media is missing," and then bringing up the 
missing media dialog, it says "I don't have access to this folder, I must not be able to open 
the project either, or perhaps FCP 6.0.3 or newer created it."

This is undoubtedly a bug and not related to any corrupt media or speed changes. It is easy 
to duplicate the steps to cause FCP to return this error.

In my testing, this error will only come up if the path that FCP is trying to look at does exist 
and there is some folder in the path that the current user doesn't have permission to open.

If you take the file to another computer that doesn't have that path, then FCP will 
appropriately consider the media missing and prompt you to reconnect it. If you reconnect the 
media and save the file, it will then open correctly on the original computer. If you don't 
reconnect the media, but you do save the file, FCP will not be able to open it on the original 
computer.

If the path FCP is having problems with leads to media or renders, then you can look at the 
list of missing media to see what paths FCP is trying to look into and check permissions for 
each path. 

However, in some cases, the project may be looking for a waveform cache file. This is 
especially annoying, because if FCP doesn't find a waveform cache file, it should quietly 
recreate it on the fly if it needs to. Unfortunately, it doesn't matter what FCP is looking for, if it 
tries to go down a path and hits a folder it doesn't have permission to open, even for a 



waveform cache file, it will return the "unreadable or too new" error.

The gotcha on this is that, because FCP doesn't normally notify you of missing cache files, 
there is no easy way to tell if this could be the culprit. Luckily, if you are able to get to the 
missing media dialog and can reconnect the media and save the project, that will also fix the 
reference to the waveform cache files and the project will open on the original computer 
correctly.

The way I discovered the significance of the referenced waveform cache files was by opening 
up some of our problem projects in TextEdit and doing a search for various user's short 
names. Problem projects had paths going to waveform cache folders inside a user's Final Cut 
Pro Documents folder that was not the user I was logged in as. Projects that were still 
working correctly did not have such path references.

I also confirmed this by creating two versions of a project: one in which the audio waveforms 
were never looked at and one in which they were (media was accessible to both test users). 
The project that never displayed the waveforms could be opened normally by a different user. 
The project that had the waveforms displayed (either in the timeline or the viewer) could not 
be opened by a different user.

The Second Gotcha 

When a project makes a path to a file and that path starts from the startup disk, FCP will 
include the name of that disk in the path to that file. If the project is opened while booted from 
a different disk, FCP will look for a disk with the name of the original startup disk as the 
starting point for its search. If it doesn't find one, it will use the current startup disk as the 
starting point of the search. That means there are potentially two places where FCP could try 
to look that the user might not have permissions for, thus resulting in the error.

For example:  
When we moved from Tiger to Leopard, we left our Tiger startup disk alone, and added a 
second disk to do a clean install of Leopard. On one machine, we had two startup disks. 

The installs of both Tiger and Leopard were almost identical except for the OS versions, 
including the user accounts on each disk. The Tiger disk was called "MainHD", but we 
renamed it "OldHD" and named the new Leopard disk "NewHD". 

Also, on our Tiger disk, all users had complete access to the other users home folders 
(security was not an issue on this machine), which is why we never came across this error 
before. On the new Leopard disk, users did not have access to each other's home folders.

So, in Leopard, if we opened certain projects, FCP would look for "MainHD", not find it, then 
look at the current startup disk, "NewHD" and follow the rest of the path. 

If the project referenced a waveform cache file in a different user's folder, FCP would return 
the error because it was looking in that user's folder on the Leopard disk, which the current 
user didn't have access to.

If we named the Tiger disk back to "MainHD", the file would open correctly because it was 
looking in the old Tiger user's folder. 

If we set the name of the Tiger disk back to "OldHD" and also changed the name of the 
offending user's home folder on the Leopard disk (temporarily for testing), the project would 
open OK. 

If we gave the current user full access to the other user's home directory, FCP would 
complete it's search and realize that the waveform cache file was not there, and the project 
would open successfully. 

(FYI, If we rebooted into Tiger (with the name of the Tiger disk still called "OldHD") the 
project would open OK.)



This is a serious bug that practically prohibits the sharing of projects on a single, multi-user 
machine or even between multiple machines with similar lists of users, with a default install of 
Final Cut Pro. Either permission will need to be granted for users to access other users' 
home folders, or the scratch disk settings for each user will need to be changed to be stored 
in a place accessible by all users (such as /Users/Shared/ or something similar) and have 
permission to access the waveform cache folders granted for all users.

FYI, this error appeared for us when using FCP 6.0.2 to open projects created in FCP 5.1.4 
through 6.0.2.

Hopefully Apple will pay attention to this bug and fix it soon.

Sorry this was such a long post, but Apple really didn't make it easy to diagnose, understand, 
and explain. I know I would've much preferred a simple "missing media" dialog than having to 
go through all of this.

Larry replies: Thanks, Alex, for sharing this. I'll pass it along in hopes it can help others.

[ Go to Top. ] 

EXPORTING TO FLV 

Nico Nilsen writes:

I have a question: you show how to export from Final Cut into compressor and compress 
according to different settings.

But I've heard about exporting as "FLV" and I understand that must be flash video. But what 
setting is that? Where is it in compressor. How can this be done ? In Flash ? Could you let 
me know or tell me where I can read about it. How can I get a "FLV" out of FCP ? Mystery ! 

Larry replies: Yes, FLV is a Flash Video format. 

At this point, you can't do this natively with Final Cut. However, Sorenson Squeeze, On2, and Telestream's 
Episode can all create FLV files. 

UPDATE - April 8, 2008

Ben Balser sent in the following:

Well, I almost got through this newsletter with no comments. Then, BANG! Just one. FCP will 
not export .FLV files, but QT Pro Player will. Save out as a native self-contained .MOV from 
FCP, open in QT Pro Player, Export as .FLV. And from my understanding, this is not a file 
you can just post to a web site, but one that would be imported into a Flash project for 
authoring.

Then, Ryan Mast sent this in:

Regarding the question about how to export an FLV from Final Cut, there is a very direct way 
-- if you own Adobe CS3. CS3 installs an FLV encoding component into QuickTime that uses 
the Flash CS3 Video Encoder dialogue box to export.

Here's how: File > Export > Using QuickTime Conversion, and from the Format pop-up 
menu, select Flash Video (FLV). The Options button summons the encoder settings window 
from the Flash Video Encoder.

http://www.sorensonmedia.com/
http://www.on2.com/
http://www.telestream.net/products/episode_series.htm
http://www.telestream.net/products/episode_series.htm


This also works from QuickTime Player, Compressor, or any app that uses the standard 
QuickTime export dialogue box.

In Compressor, in the Inspector window, select QuickTime Export Components from the 
File Format pop-up menu, and select Flash Video (FLV) from the Encoder Type pop-up 
menu. Again, the Options button summons the Flash Video Encoder options.

I really haven't tested which is faster -- exporting via Adobe's QuickTime FLV encoder 
component, or encoding directly with the Flash Video Encoder app. Any one else have a 
word on that?

Larry replies: Thanks, Ben and Ryan. I didn't know this. 

[ Go to Top. ] 

SNAPPING IS GETTING WEIRD 

Marcia Orland writes:

A weird thing just started happening a couple weeks ago. The snapping tool doesn't maintain 
the off/on position I select. In other words, if I turn snapping on, I do something on the 
timeline, and the snapping goes off by itself. Or, sometimes it's the other way around. I can't 
find any setting which would override the 'N' key, which I use. Have you heard of this??

Larry replies: Yes. This is new behavior with Final Cut Pro 6.0.2.

Basically, if you change snapping without holding down the mouse button, everything works as normal. 
However, if you are holding the mouse down when typing N this is only temporary. Once you let go of the 
mouse button, snapping reverts to the state it was in before you clicked the mouse.

Also new with 6.0.2, if you hold down the Option key while dragging, this will temporarily turn on snapping.

[ Go to Top. ] 

WHAT'S GOING ON HERE?!? 

Phillip Brown writes:

Thanks for your website and newsletter. I'm still learning FCP. I was editing last night and 
leaned on my keyboard and now my playhead is like this (see attached photo) It's offsetting 
my Out marker. I spent two hours searching the manual to find out what I did but couldn't find 
anything. Please HELP !! 

Next to the playhead is a black bar. When I set the playhead where I want to Mark Out, it 
Marks at the end of that Black bar instead. It's making my already crazy mind worse. What is 
that??? An offset of some kind?

Larry replies: Nope.



Final Cut is called an "inclusive" editor, because it always includes the frame that is showing in the Canvas. 
The black bar represents the frame currently showing in your Canvas.

The playhead always parks at the beginning of the frame, then the Out is set at the end of the frame - 
1/30th of a second later for NTSC video; 1/25th of a second later for PAL. 

When you set the In, you'll see that it directly touches the playhead. This means that the shortest edit you 
can do in Final Cut is one frame long. If the Out did not set at the end of the frame, it would be technically 
possible to do a zero frame edit - which makes no sense at all.

What you are seeing is completely normal - its just that zooming in makes it seem alarming.

[ Go to Top. ] 

WHITE BALANCING DURING A COLOR CHANGE 

Chris Skinner writes:

Is there a technique to white balance in this situation.

Going from outside to inside; This is a steady-cam clip:

1.  Camera, with on camera 50w light (white balanced to natural light) is approaching 
door.

2.  Door opens and tungsten light makes everything yellow as camera now goes into the 
interior.

I would like to adjust the white balance in a way that does not have the sharp change from 
exterior white balance to interior white balance.

The alternative I think is to "razor," making two clips, and use a dip-to-color transition. 
However, I would loose the entire "continuous look" I was trying to use.

Larry replies: Chris, you can't re-white-balance while shooting.

But you can change color correction settings during editing so that a clip changes color to account for the 
shift in light - by using keyframes in the color correction filter. 

To do so: 

�●     Apply the Color Correction 3-way filter to the clip in question.
�●     Double-click the clip to load it into the Viewer and click the Color Corrector 3-way tab at the top of 

the Viewer window. 
�●     Color correct the first portion of your clip so it looks the way you want.  

 

 
 

�●     When the transition to other color light starts, click the open diamond Ins/Del keyframe button to set 
a starting keyframe.

�●     Go to the end of the transition to the differently colored light and set a second keyframe. Without 
moving your playhead, adjust your colors until things look normal.



Now, as you move from one color light to another, the color corrector filter will compensate for the 
difference, keeping everything looking normal.

Here's an article that explains a simple way to color correct, if this filter is new to you.

UPDATE - April 8, 2008

Shaun Roemich, of Gearhead Visual, sent in the following update:

Actually, you can change white balance while shooting if your camera has 2 manual white 
balance positions (A & B) on an external switch, such as most pro shoulder cams along with 
many of the newer HDV cameras have. Simply set white balance on B, go outside (in this 
example), white balance normally, go back inside and set white balance to A, white balance 
normally. Begin shooting outdoors and as you approach the threshold, simply flick the WB 
switch from A to B and Voilá! Some cameras even allow you set set the transistion between 
the two white balance values to be smoother (via the engineering menu typically).

Larry replies: Thanks, Shaun. 

[ Go to Top. ] 

COPYING JUST SOME MEDIA 

Bob Cusumano writes:

Is there a way to copy the media in the timeline and only the media in the timeline so you can 
put them on another drive to give to another editor. Could you point me to an article or 
explain in some detail how to do this. The editor says she has to copy the whole media clip, 
not just the piece she needs in order to get the information onto that other drive. Thank you, 
Bob C.

Larry replies: Bob, this is where you need to use Media Manager to remove the video you are not using.

Because you are actually deleting media, and because Media Manager is not the easiest function to 
understand, I'm going to refer you to an article I wrote that discusses this.

Also, ALWAYS do a test on media you don't need and read the Apple manual on this. Media Manager has 
LOTS of options and many traps - the manual takes over 100 pages to discuss all the options.

Read first, practice second, then do it for real. Otherwise, media that you need may disappear permanently.

[ Go to Top. ] 

PROBLEMS WITH FRAME RATES 

Robert Hurt writes:

I produce an HD vodcast for NASA that involves a fair amount of pan and scan movies 
generated from images. Since these often exceed Motions 4k image resolution I typically will 
render these in After Effects.

My problem is this. We produce at 720p24 to be AppleTV compatible, and as we use an 
HVX200 in 720p24N format I've standardized on a FCP sequence format of full 720x1280 (to 

http://www.larryjordan.biz/articles/lj_color.html
http://www.larryjordan.biz/articles/lj_media_mgr_delete.html


preserve full resolution of our animations) at 23.98 fps (to match the HVX footage).

The problem arises when I try to export Quicktime format movies from AE (version 6.5 still) at 
1280x720 at 23.98 fps. By all observable indicators this is an identical frame rate to my FCP 
and Motion timelines, but when I import it there seems to be significant stuttering.

In FCP it plays back nice on-screen, but anytime there is a transition the rendered result 
stutters. If I force the entire export to recompress then all of the animation stutters, including 
the transitions.

If I put it into Motion, the stuttering is immediately obvious, as stepping through frame by 
frame yields irregular results.

The only workaround I've found so far is to export as a frame sequence, import into 
Quicktime Pro at 23.98, export into ProRes .mov, then import that. This gets kind of kludgy 
with lots of clips.

Is there a known frame rate disconnect between AE and FCP, or perhaps some magic 
settings that would allow for a more direct export to .mov workflow?

Larry replies: My suspicion is that the frame rates between FCP and AE don't match. Take a closer look 
there.

Robert then wrote back:

The frame rate is INDEED the trick, and FCP appears to be VERY picky about its exact value.

If I export from AE a ProRes .mov with the frame rate set EXACTLY to 23.976 then FCP 
ingests it and renders it fine.

If the AE export is set to 23.98 (which I had been doing) then FCP ingests it, displays it, but 
gags on the render because it appears to not truly accept it and apparently conforms its 
sequence to be 23.976 instead.

The trick of it is that the info panel in QuickTime shows both movies to be 23.98 fps, so 
there's no obvious way that I can find to tell the difference between a "good" 23.976 and a 
"bad" 23.98.

You'd hardly expect that a 0.004 fps variation should cause FCP and/or QuickTime to muck 
up roughly every third frame on re-render, but apparently it DOES!

Who knew?

Larry replies: Robert, thanks for sending us the solution. I'm delighted to share it with others.

UPDATE - April 8, 2008

Tom Wolsky sent in the following:

FCP calls its frame rate 23.98 for shorthand, but the real frame rate is 23.976, which rounds-
up to 23.98. FCP only lets you make sequences in specific, exact frame rates, it's 23.98 is 
really 23.976. AE on the other hand will make any crazy frame rate you want, 22.4, 28.3, 
anything. You asked for 23.98, you got 23.98. As Robert found out, you have to ask for the 
real "24p" frame rate, which is 23.976.

Larry replies: Thanks, Tom. 

[ Go to Top. ] 



INDIE MOVIES SOLD OVER iTUNES? 

Garnet Campbell writes:

I remember hearing something about a site being developed that helps distribute indie 
movies using itunes and the podcast section or something... Can you tell me more about that?

Larry replies: Nope. But I'm happy to pass on anything suggested by a reader.

[ Go to Top. ] 

NOW FOR SOMETHING TRULY WEIRD 

Philip Hodgetts sent this in for everyone looking for CG-based actors. Move your mouse and watch what 
happens. This may be the future of web-based news-reading, but, I still haven't decided what my reaction to 
this is.

http://cubo.cc/ 

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this month. For current news on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week.

I look forward to seeing you next week at the SuperMeet!

In the meantime, please continue sending me your comments and questions. I love hearing from you and 
enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 600 KB ]
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up 
at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold, 
rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying these 
ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has 
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the 
property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2008 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter 
may not be reproduced or published in any way, in whole or in part, without specific written 
permission from the author. 

Links to my home page or website articles are welcome and don't require prior permission. 
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